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Installing OptiSystem

Before installing OptiSystem, ensure the system requirements described below are 
available.

Hardware and software requirements

OptiSystem requires the following minimum/recommended system configuration:

• Minimum PC configuration: PC with Pentium 4 processor or equivalent with 2G 
MB RAM. 

• Recommended PC configuration: PC with a clock speed > 2 GHz with 2-4 cores 
(e.g. Intel i7 3rd/4th Gen, AMD Athlon/Athlon II) and 8MB RAM.

• Operating Systems: Microsoft Windows 7 & 8.1 (32-bit/64-bit)

For optimum software performance, we recommend the 64-bit version of Opti-
System (64-bit version) installed on a Windows 7 (64-bit) or Windows 8.1 (64-
bit) operating system. 

Note 1: For Windows XP users a separate version of OptiSystem 13.0 is avail-
able. Please contact info@optiwave.com for further information. Please note 
that Optiwave will no longer support the Windows XP version of OptiSystem 
starting in 2015 (OS 14.x).

Note 2: Optiwave will no longer support the 32-bit version of OptiSystem starting 
in 2015 (OS 14.x).

• 400 MB free hard disk space

• 1024 x 768 graphic resolution, minimum 65536 colors

• Internet Explorer 5.5 or higher (to enable VBScript functionality)

Protection key

A hardware protection key is supplied with the software.

Note: Please ensure that the hardware protection key is NOT connected during 
the installation of OptiSystem.

To ensure that OptiSystem operates properly, verify the following:

• The protection key is properly connected to the parallel/USB port of the computer.
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• If you use more than one protection key, ensure that there is no conflict between 
the OptiSystem protection key and the other keys.

Note: Use a switch box to prevent protection key conflicts. Ensure that the cable 
between the switch box and the computer is a maximum of one meter long.
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OptiSystem directory

By default, the OptiSystem installer creates an OptiSystem directory on your hard 
disk. The OptiSystem directory contains the following subdirectories:

• \bin — executable files, dynamic linked libraries, and help files

• \components — OptiSystem component parameters from vendors

• \documentation — OptiSystem support documentation

• \libraries — OptiSystem component libraries

Installation

We recommend that you exit all Windows programs before running the setup 
program. To install OptiSystem, perform the following procedure.

Step Action 

1 Log on as the Administrator, or log onto an account with Administrator 
privileges.

2 Insert the OptiSystem CD into your CD ROM drive.

3 On the Taskbar, click Start and select Run.
The Run dialog box appears.

4 In the Run dialog box, type F:\setup.exe, where F is your CD ROM drive

Note: If the software was provided in electronic (downloaded) format, double 
click on the “setup.exe” file in the software installation folder.

5 Click OK and follow the screen instructions and prompts.

6 When the installation is complete, reboot your computer.

Note: OptiSystem samples are no longer automatically installed during 
installation. To install the OptiSystem samples folder right-click and open (or 
double-click) on the “OptiSystem_Samples.exe” file within the OptiSystem 
installation folder.

Technical support

(613) 224-4700—Monday to Friday, 9:00 a.m. to 5:00 p.m. Eastern 
Standard Time

(613) 224-4706

Phone

Fax

E-Mail support@optiwave.com

URL www.optiwave.com

mailto:support@optiwave.com
http://www.optiwave.com
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Introduction
Optical communication systems are increasing in complexity on an almost daily basis. 
The design and analysis of these systems, which normally include nonlinear devices 
and non-Gaussian noise sources, are highly complex and extremely time-intensive. 
As a result, these tasks can now only be performed efficiently and effectively with the 
help of advanced new software tools.

OptiSystem is an innovative optical communication system simulation package that 
designs, tests, and optimizes virtually any type of optical link in the physical layer of a 
broad spectrum of optical networks, from analog video broadcasting systems to 
intercontinental backbones. 

OptiSystem is a stand-alone product that does not rely on other simulation 
frameworks. It is a system level simulator based on the realistic modeling of fiber-optic 
communication systems. It possesses a powerful new simulation environment and an 
hierarchical definition of components and systems. Its capabilities can be extended 
easily with the addition of user components, and can be seamlessly interfaced to a 
wide range of tools.

A comprehensive Graphical User Interface (GUI) controls the optical component 
layout and netlist, component models, and presentation graphics (see Figure 1 on 
page 12). 

The extensive library of active and passive components includes realistic, 
wavelength-dependent parameters. Parameter sweeps allow you to investigate the 
effect of particular device specifications on system performance. 

Created to address the needs of research scientists, optical telecom engineers, 
system integrators, students, and a wide variety of other users; OptiSystem satisfies 
the demand of the booming photonics market for a powerful and easy-to-use optical 
system design tool.
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Benefits
• Rapid, low-cost prototyping

• Global insight into system performance

• Straightforward access to extensive sets of system characterization data

• Automatic parameter scanning and optimization

• Assessment of parameter sensitivities aiding design tolerance specifications

• Dramatic reduction of investment risk and time-to-market

• Visual representation of design options and scenarios to present to prospective 
customers

Applications

OptiSystem allows for the design automation of virtually any type of optical link in the 
physical layer, and the analysis of a broad spectrum of optical networks, from long-
haul systems to MANs and LANs.

OptiSystem’s wide range of applications include:

• Optical communication system design from component to system level at the 
physical layer

• CATV or TDM/WDM network design

• Passive optical networks (PON) based FTTx

• Free space optic (FSO) systems

• Radio over fiber (ROF) systems

• SONET/SDH ring design

• Transmitter, channel, amplifier, and receiver design

• Dispersion map design

• Estimation of BER and system penalties with different receiver models

• Amplified system BER and link budget calculations

Samples library

OptiSystem includes an extensive library of sample optical design (.osd) files (in 
excess of 200) that can be used as templates for optical design projects or for learning 
and demonstration purposes.
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Main features

The main features of the OptiSystem interface include:

Feature Description

Component Library To be fully effective, component modules must be able to 
reproduce the actual behavior of the real device and 
specified effects according to the selected accuracy and 
efficiency. The OptiSystem Component Library includes 
hundreds of components, all of which have been carefully 
validated in order to deliver results that are comparable with 
real life applications.

Measured components The OptiSystem Component Library allows you to enter 
parameters that can be measured from real devices. It 
integrates with test and measurement equipment from 
different vendors.

Integration with Optiwave 
Software Tools

OptiSystem allows you to employ specific Optiwave software 
tools for integrated and fiber optics at the component level: 
OptiAmplifier, OptiBPM, OptiGrating, WDM_Phasar, 
OptiFiber & OptiSPICE.

Mixed signal 
representation

OptiSystem handles mixed signal formats for optical and 
electrical signals in the Component Library. OptiSystem 
calculates the signals using the appropriate algorithms 
related to the required simulation accuracy and efficiency.

Quality and performance 
algorithms

In order to predict the system performance, OptiSystem 
calculates parameters such as BER and Q-Factor using 
numerical analysis or semi-analytical techniques for systems 
limited by inter symbol interference and noise.

Advanced visualization 
tools

Advanced visualization tools produce OSA Spectra, signal 
chirp, eye diagrams, polarization state, constellation 
diagrams and much more. Also included are WDM analysis 
tools listing signal power, gain, noise figure, and OSNR per 
channel.

Data monitors You can select component ports to save the data and attach 
monitors after the simulation ends. This allows you to 
process data after the simulation without recalculating. You 
can attach an arbitrary number of visualizers to the monitor 
at the same port.

Hierarchical simulation 
with subsystems

To make a simulation tool flexible and efficient, it is essential 
to provide models at different abstraction levels, including 
the system, subsystem, and component levels. OptiSystem 
features a truly hierarchical definition of components and 
systems, enabling you to employ specific software tools for 
integrated and fiber optics at the component level, and 
allowing the simulation to be as detailed as the desired 
accuracy dictates.
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User-defined 
components

You can incorporate new components based on subsystems 
and user-defined libraries, or use co-simulation with a third 
party tool such as MATLAB or Simulink.

Powerful Script language You can enter arithmetical expressions for parameters and 
create global parameters that can be shared between 
components and subsystems using standard VB Script 
language. The script language can also manipulate and 
control OptiSystem, including calculations, layout creation 
and post-processing when using the script page.

State-of-the-art 
calculation data-flow

The Calculation Scheduler controls the simulation by 
determining the order of execution of component modules 
according to the selected data flow model. The main data 
flow model that addresses the simulation of the transmission 
layer is the Component Iteration Data Flow (CIDF). The 
CIDF domain uses run-time scheduling, supporting 
conditions, data-dependent iteration, and true recursion.

Multiple layouts You can create many designs using the same project file, 
which allows you to create and modify your designs quickly 
and efficiently. Each OptiSystem project file can contain 
many design versions. Design versions are calculated and 
modified independently, but calculation results can be 
combined across different versions, allowing for comparison 
of the designs.

Report page A fully customizable report page allows you to display any 
set of parameters and results available in the design. The 
produced reports are organized into resizable and moveable 
spreadsheets, text, 2D and 3D graphs. It also includes HTML 
export and templates with pre-formatted report layouts.

Parameter sweeps and 
optimizations

Simulations can be repeated with an iterated variation of the 
parameters. OptiSystem can also optimize any parameter to 
minimize or maximize any result or can search for target 
results. You can combine multiple parameter sweeps and 
multiple optimizations.

OptiPerformer For any given system topology and component specification 
scenario, a full OptiSystem project can be encrypted and 
exported to OptiPerformer. OptiPerformer users can then 
vary any parameter within defined specification ranges, and 
observe resulting system effects via detailed graphics and 
reports.

Bill of materials OptiSystem provides a cost analysis table of the system 
being designed, arranged by system, layout or component. 
Cost data can be exported to other applications or 
spreadsheets.

Feature Description
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Notes:
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Quick Start
This section describes how to load a design, run a simulation, edit local and global 
parameters, and obtain results. The most efficient way to become familiar with 
OptiSystem is to complete the lessons in the Tutorials, where you learn how to use 
the software by solving problems.

Note: For the users of the Amplifier Edition of OptiSystem we recommend to follow 
Lesson 7: Optical Amplifiers - Designing optical fiber amplifiers and fiber lasers, and 
for the users of the Multimode Edition of OptiSystem we recommend to follow Lesson 8: 
Optical Systems - Working with multimode components. Both lessons are available in 
the OptiSystem tutorials book. 

Starting OptiSystem

To start OptiSystem, perform the following action.

Action 

• From the Start menu, select Programs > Optiwave Software> 
OptiSystem 12 > OptiSystem.
OptiSystem loads and the graphical user interface appears
(see Figure 1).
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Figure 1 OptiSystem graphical user interface (GUI)
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Main parts of the GUI

The OptiSystem GUI contains the following main windows:

• Project layout

• Dockers

— Component Library

— Project Browser

— Description

• Status Bar

Project layout

The main working area where you insert components into the layout, edit 
components, and create connections between components (see Figure 2).

Figure 2 Project layout window
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Dockers

Use dockers, located in the main layout, to display information about the active 
(current) project:

— Component Library

— Project Browser

— Description

Component Library

Access components to create the system design (see Figure 3).

Figure 3 Component Library window

Project Browser

Organize the project to achieve results more efficiently, and navigate through the 
current project (see Figure 4).

Figure 4 Project Browser window
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Description

Display detailed information about the current project (see Figure 5).

Figure 5 Description window

Status Bar

Displays project calculation progress information, useful hints about using 
OptiSystem, and other help. Located at the bottom of the Project Layout window.

Figure 6 Status Bar
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Loading a sample file

To load a sample file, perform the following procedure.

Step Action 

1 From the File menu, select Open.

2 In Samples > Introductory Tutorials, select Quick Start Direct 
Modulation.osd.
The Direct Modulation sample file appears in the Main layout (see 
Figure 7).

Figure 7 Direct Modulation sample file

The transmitter is built using a direct laser modulation scheme, and consists of the 
following components:

• Pseudo-Random Bit Sequence Generator: Sends the bit sequence to the NRZ 
Pulse Generator. The pulses modulate the Laser Measured. The 
Photodetector PIN receives the optical signal attenuated by the Optical 
Attenuator. The Low Pass Bessel Filter filters the electrical signal.

• Optical Spectrum Analyzer: Displays the modulated optical signal in the 
frequency domain
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• Optical Time Domain Visualizer: Displays the modulated optical signal in the 
time domain.

• Oscilloscope Visualizer: Displays the electrical signal after the PIN in time 
domain.

• BER Analyzer: Measures the performance of the system based on the signal 
before and after the propagation.

Note: More than one visualizer can be attached to a component output.

Running a simulation

To run a simulation, perform the following procedure.

Step Action 

1 From the File menu, select Calculate (see Figure 8).
The OptiSystem Calculations dialog box appears (see Figure 9).

Figure 8 File menu
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Figure 9 OptiSystem Calculations dialog box

2 In the OptiSystem Calculations dialog box, click the Run button 
(see Figure 9).
The results appear in the Calculation Output window.
The calculation output appears in the Calculation Output window, and the 
simulation results appear below the components that were included in the 
simulation.
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Displaying results from a visualizer

To view the simulation results, perform the following action.

Action 

• Double-click a visualizer in the Project layout to view the graphs and results 
that the simulation generates (see Figure 10).

Figure 10 Optical Time Domain Visualizer results
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Component parameters

Viewing and editing component parameters

Double-click a component to view and edit the parameters for the component. To view 
the properties for Laser Measured, perform the following action.

Action 

• In the Project layout, double-click the Laser Measured component.
The Laser Measured Properties dialog box appears.

Figure 11 Component parameters – Laser Measured
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Component parameters are organized by categories. Laser Measured has seven 
parameter categories, each represented by a tab in the dialog box (see Figure 11).

• Main

• Measurements

• Initial estimate

• Numerical

• Graphs

• Simulation

• Noise

• Random numbers

Each category has a set of parameters. Parameters have the following properties:

• Disp

• Name

• Value

• Units

• Mode

The first category in the Laser Measured dialog box is Main. You can enter the signal 
Frequency and Power using the Main tab.

The first parameter in the Main category is Disp. When you select a check box beside 
a parameter listed in the Disp column, the parameter value appears under the 
component in the Project layout. For example, if you select the Frequency and 
Power check boxes in the Disp column, these parameter values appear in the 
Project layout (see Figure 12).

Figure 12 Laser Measured with displayed parameter values

Each parameter can have a value in the columns Name, Value, Units, and Mode. 
Some parameters can have different units. For example, you can select the 
Frequency parameter to be in Hz, THz, or nm. When you change your unit selection, 
the conversion is automatic (see Figure 13).
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Figure 13 Choosing parameter values
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Editing parameters

To edit the NRZ Pulse Generator parameters, perform the following procedure.‘

Step Action 

1 Double-click the NRZ Pulse Generator in the Project layout.
The NRZ Pulse Generator Properties dialog box appears (see Figure 14).

2 Click the Simulation tab.

Figure 14 Laser NRZ Pulse Generator simulation options
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For the Sample rate parameter, the Mode is Script (see Figure 15). This parameter 
will be evaluated as an arithmetic expression. The Sample rate parameter of the 
Laser Measured component also refers to a Global parameter with the same name.

Figure 15 Scripted parameters
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Editing visualizer parameters

To access the parameters for the Optical Spectrum Analyzer, perform the following 
procedure.

Step Action 

1 Right-click the Optical Spectrum Analyzer.
A shortcut menu appears (see Figure 16).

Figure 16 Shortcut menu

2 Select Component Properties.
The Optical Spectrum Analyzer Properties dialog box appears (see 
Figure 17).
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Figure 17 Optical Spectrum Analyzer Properties dialog box
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Global parameters

The global parameters are common to all OptiSystem simulations. (See Appendix A: 
Global Parameters for more information on global parameters.) In this particular case, 
you indirectly define the simulation time window, the number of samples, and the 
sample rate using three parameters:

• Bit rate

• Bit sequence length

• Number of samples per bit

These parameters are used to calculate the Time window, Sample rate, and 
Number of samples.

• Time window = Sequence length * 1/Bit rate = 256 * 1 / 10e9 = 25.6 ns

• Number of samples = Sequence length * Samples per bit = 32768 samples

• Sample rate = Number of samples / Time window = 1.28 THz

The time window of the simulation is 25.6 ns. 32768 samples will be generated by 
each component, and the signal bandwidth is 1.28 THz.

OptiSystem shares the parameter Time window with all components. This means 
that each component works with the same time window. However, each component 
can work with different sample rates or number of samples (see Figure 18).
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Figure 18 Global parameters values
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Editing global parameters

To edit global parameters, perform the following procedure.

Step Action 

1 Double-click in the Project layout.
The Layout 1 Parameters dialog box appears (see Figure 18).

2 Select or clear global parameters as required.

These parameters can be accessed by any component using the script mode. The 
NRZ Pulse Generator refers by default to the global parameter Sample rate using 
script mode (see Figure 19). The Low Pass Bessel Filter has the Cutoff parameter 
frequency as 0.75 * Bit rate. In this case, Bit rate is a global parameter (see 
Figure 20).

Figure 19 NRZ Pulse Generator properties
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Figure 20 Low Pass Bessel Filter properties
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Using the Layout Editor

In the following example, you will modify a design that you create. You will change the 
laser modulation scheme from direct to external modulation by replacing some of the 
components in the design and adding components from the Component Library.

To use the Layout Editor, perform the following procedure.

Step Action 

1 To delete the Laser Measured component, select the Laser Measured 
component in the Project layout and press the Delete key.
The Laser Measured component is deleted from the layout.

2 From the Component Library, select Default > Transmitters Library > 
Optical Sources.

3 Drag the CW Laser to the Project layout (see Figure 21).

Note: The autoconnect feature automatically connects components in the 
Project layout. If connections are not made automatically, see “Connecting 
components manually” on page 33.

Figure 21 CW Laser added to Main Layout
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4 From the Component Library, select Default > Transmitters Library > 
Optical Modulators.

5 Drag the Mach-Zehnder Modulator to the Project layout (see Figure 22).

6 Place the Mach-Zehnder Modulator in the Project layout so the following 
connections are generated:

a. NRZ Pulse Generator output port to the Mach-Zehnder modulation 
input port

b. CW Laser output port to the Mach-Zehnder Modulator Carrier input port

c. Mach-Zehnder Modulator output port to the Optical Attenuator input 
port

Figure 22 Connecting components

7 Connect the Mach-Zehnder Modulator output port to the Optical Spectrum 
Analyzer input port and to the Optical Time Domain Visualizer input port 
(see Figure 23).
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Figure 23 Mach-Zehnder Modulator connected to visualizers

8 From the File menu, select Calculate.
The OptiSystem Calculations dialog box appears.

9 Click the Run button.
The results appear in the Calculation Output window.

10 To view the graphs and results, double-click on the visualizers (see Figure 25 
and Figure 26 for examples of visualizer results).

Connecting components manually

To connect components using the layout tool, perform the following procedure.

Step Action 

1 Place the cursor over the initial port.
The cursor changes to the rubber band cursor (chain link) (see Figure 24).
A tool tip appears that indicates the type of signal that is available on this port.

2 Click and drag to the port to be connected.
The ports are connected.

Note: You can only connect output to input ports and vice versa.

Figure 24 Rubber Band cursor
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Figure 25 Visualizer results — OSA example
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Figure 26 Visualizer results — BER example

Saving the design and closing OptiSystem

To save the design and close OptiSystem, perform the following procedure.

Step Action 

1 From the File menu, select Save.
The Quick Start Direct Modulation.osd design is saved.

2 From the File menu, select Exit.
OptiSystem closes.
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Notes:
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Appendix A: Global Parameters

Opening the global parameters dialog

To open the global parameters dialog, perform the following action.

Action 

• Double-click in the Project layout window.
The Layout Parameters dialog opens (see Figure 27).

OR

• Select Layout > Parameters from the Menu tool bar.
The Layout Parameters dialog opens (see Figure 27).

Editing global parameters

To edit global parameters, perform the following procedure.

Step Action 

1 Double-click in the Project layout.
The Layout Parameters dialog box appears (see Figure 27).

2 Select or clear global parameters as required.
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Figure 27 Layout Parameters dialog
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When you create a new design, you must define the global simulation parameters. 
These parameters are critical to the simulation. 

They show the speed, accuracy, and memory requirements for a particular simulation 
during the system design stage. It is important to understand what the global 
parameters are, because they have an impact on all the components that use these 
parameters (see Figure 28).

Figure 28 Global parameters relationships

Time spacing = 1 / Sample rate = Time window / Number of samples

Frequency spacing = 1 / Time window = Sample rate / Number of samples

Time window = Sequence length * Bit period = Sequence length / Bit rate

Number of samples = Sequence length * Samples per bit = Time window * Sample 
rate
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Simulation parameters

Figure 29 Simulation parameters

Simulation window

Specifies the setup mode for entering the parameters that define the main simulation 
parameters:

• Set bit rate: Allows you to enter the Bit rate. This is the default mode — you can 
easily set up the simulation using typical parameters such as Bit rate, Sequence 
length, and Samples per bit.

• Set time window: Allows you to enter the Time window value

• Set sample rate: Allows you to enter the Sample rate

The parameter Bit rate recalculates based on these parameters.
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Reference bit rate

If this parameter is enabled, when you select Set time window or Set sample rate 
in the Simulation window, it will find the closest Time window or Sample rate without 
changing the Bit rate.

Bit rate

The value of the global bit rate is in bits per second. All components can access this 
parameter (see Figure 30). The global bit rate can affect components such as Bit 
sequence generators because components that require this parameter use is as a 
default value.

An expression relative to this bit rate value is used to define the default value for the 
bandwidth or cutoff frequency of most electrical filters. When you change this global 
parameter, you can change the bit rate setting of all modules in the design 
simultaneously.

Figure 30 Global parameter Bit rate

Bit rate



 APPENDIX A: GLOBAL PARAMETERS

42

Time window

Specifies in seconds the Time window of the simulation. OptiSystem shares the 
parameter Time window with all components. This means that each component 
works with the same Time window. Since the Time window defines the frequency 
spacing in the frequency domain, the sampled signal will always have the same 
frequency spacing. This parameter is best expressed in terms of the sequence length 
and the bit rate used during the simulation. It affects all components.

Sample rate

Specifies the frequency simulation window or simulation bandwidth in Hz (see 
Figure 31). It can affect components such as pulse generators and optical sources 
that generate signals at different sample rates. It is often convenient to operate all 
modules in the design at the same sample rate. This can be done easily by using this 
global parameter. The default parameter for all components requiring sample rate is 
referred to as the global sample rate. When you change this global parameter, you 
can change the sample rate setting of all modules in the design simultaneously.

Figure 31 Global parameter Sample rate
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Sequence length

The length of the bit sequence in number of bits. It must be a power of two.

Figure 32 Global parameter Sequence length

Sequence length

Samples per bit

Number of samples for bit used to discretize the sampled signals. It must be a power 
of two.

Number of samples

This read-only parameter shows the number of samples calculated by the product of 
Sequence length and Samples per bit.
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Figure 33 Global parameter iterations
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Signals parameters

Figure 34 Global parameters Signals
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Iterations

Number of signal blocks generated by each simulation. It mainly affects transmitters 
and components used in bidirectional simulations and in network ring design. 

By increasing the parameter iterations a component will repeat the previous 
calculation until the number of calculations is equal to the iterations. Refer to the 
tutorial lesson: Working with multiple iterations.

Initial Delay

This parameter forces a component to generate a null signal at each output port. It 
affects all components and it is mainly used in bidirectional simulations. The user 
does not have to add delays at the component input ports if using this parameter. 
Refer to the tutorial lesson: Working with multiple iterations.

Parameterized

Defines whether the signal output will be sampled signals (disabled) or parameterized 
signals (enabled). It can affect components such as optical sources and optical pulse 
generators.

Synchronize

Defines whether bit rates will be recalculated in order to make sure that the number 
of samples and the number of bits are both power of two numbers. It can affect 
components such as pulse generators, decoders and BER analyzers. It forces 
compatibility mode with previous versions of OptiSystem 7.
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Noise parameters

Convert noise bins

Selects whether noise within a sampled band's frequency range is added to the 
sampled signal or represented separately as noise bins. The default value is disabled, 
which means the noise propagate is separated from the signals. It can affect the 
Erbium doped fiber amplifiers and the photo detectors.

Figure 35 Global parameters Noise
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Spatial Effects Parameters

The spatial effects parameters affect the components that generate spatial modes, 
where the discretization space and the level of the discretization should be defined. 
The number of points per spatial mode is defined as the product of the number of 
points in the X and Y coordinates.

Figure 36 Global spatial effects parameters

Space Width X

This is the space for the X coordinate. 

Space Width Y

This is the space for the Y coordinate. 
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Grid Spacing Width X

The grid spacing for the X coordinate. The space width divided by the grid spacing 
gives the number of points in the X coordinate.

Grid Spacing Width Y

The grid spacing for the Y coordinate. The space width divided by the grid spacing 
gives the number of points in the Y coordinate

Signal Tracing Parameters

OptiSystem allows for fast estimation of power and noise at each output port. This 
estimation is calculated every time a signal is sent to the component output port. The 
signal tracing parameters allow the user to control the calculation and presentation of 
the results.

Figure 37 Global signal tracing parameters
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Calculate Signal Tracing

Defines if the signal will be traced.

Power Unit

The units used to display the results (dBm, W or mW).

Frequency Unit

The units used to display the results (Hz, m, THZ or nm).

Decimal Places

The number of decimal places to use when displaying the results.

Sensitivity

The minimum output power that the calculation can detect.

Resolution

The spectral resolution bandwidth of the calculation.

Calculate Noise Floor

Defines if the noise floor will be calculated using interpolation. This is an important 
parameter when the noise is added to the signal.

Interpolation Offset

The interpolation offset from the signal channel center frequency used to estimate the 
noise floor.
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Appendix B: Signal representation
To make the simulation tool more flexible and efficient, it is essential that it provides 
models at different abstraction levels, including the system, subsystem, and 
component levels. OptiSystem features a hierarchical definition of components and 
systems, allowing you to employ specific software tools for integrated and fiber optics 
in the component level and allowing the simulation to go as deep as the desired 
accuracy requires. Different abstraction levels imply different signal representations. 
The signal representation must be as complete as possible in order to allow efficient 
simulation.

There are five types of signals in the signal library:

Binary Red

M-Ary Dark Red

Electrical Blue

Optical Green

Any Type Dark Green

Figure 38 Signal types and connections

Signal Connection color
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OptiSystem handles mixed signal formats in the Component Library for optical and 
electrical signals. It calculates the signals using different algorithms according to the 
desired simulation accuracy and efficiency.

Binary signals

Binary signals are generated by components such as bit sequence generators. Pulse 
generators in the Transmitters Library and digital switches in the Network Library use 
this signal as input data.

A binary signal consists of a sequence of ones and zeros, or marks and spaces. The 
main property of the binary signal is the Bit rate (see Figure 39).

Figure 39 Binary signal

M-Ary Signals

M-Ary signals are multilevel signals used for special types of coding, such as PAM, 
QAM, PSK, and DPSK. M-Ary signals are similar to the binary signals. However, M-
Ary signals can have any level instead of only high (1) and low (0) levels, or marks 
and spaces. Refer to the digital modulation tutorial lessons.

Electrical signals

Electrical signals are generated by components such as pulse generators in the 
Transmitters Library and photodetectors in the Receivers Library.

Electrical signals consist of the sampled signal waveform in time domain. The main 
properties of the electrical signal are the signal noise variances in the time domain 
and the noise power spectral densities in the frequency domain.
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When a pulse generator generates the electrical signal, there is no noise information 
with the signal because the signal is pure. If the electrical signal is generated by a 
photodetector, there are different sources of noise, some of which are time dependent 
and must be characterized by the time variance (for example, shot noise). Some of 
them are given as power spectral density (for example, thermal noise). The electrical 
signal creates the noise information according to the properties and the number of 
noise sources in the component (see Figure 40).

Figure 40 Electrical signal - noise variance - PSD

If the electrical signal is filtered, the noise PSD is affected immediately because the 
PSD is filtered based on the filter transfer function in frequency domain. If the noise 
is also characterized by the noise variance, it is not affected immediately. The 
information about the filter transfer function is saved in the frequency domain as a 
property of the noise. As a result, you can have a cascade of electrical filters and the 
electrical signal will keep track of the equivalent transfer function of the filters.

When using the noise variance for calculation of the signal noise, the information 
about the filters will be used to generate the equivalent noise bandwidth and will be 
applied to the noise variance (see Figure 41).

Electrical signals can also be represented by individual samples, allowing for time 
driven simulations. In order to simulate using individual samples the user should 
explicitly add the component “Convert to Individual Electrical Samples" into the layout. 
The signal and noise at the input signal will be added and converted into multiple 
samples. The number of samples is defined by the global parameter Number of 
samples. Refer to the tutorial lesson: Working with individual samples.
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Figure 41 Filtering electrical signal

Optical signals

Optical signals are generated by components such as lasers in the Transmitters 
Library. Optical signals accommodate different signal representations:

• Sampled signals

• Parameterized signals

• Noise bins

Figure 42 Mixed optical signal representation - Frequency domain
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Sampled signals

Optical signals can accommodate any arbitrary number of signal bands. In the 
simplest case, there is one single frequency band when a single, continuous 
frequency band represents the waveforms of all the modulated optical carriers. A 
single optical source (for example, CW Laser) produces a single frequency band. The 
band represents the complex sampled optical field of the signal in two polarizations. 
This type of optical signal is called a Sampled signal.

When two or more Sampled signals are combined, the individual signals will join into 
a new sampled signal if their simulation bandwidths overlap, or they are kept 
separated if the simulation bandwidth does not overlap. The resulting signal is called 
Sampled signals — in this case, each sampled signal is propagated using a separate 
sampled optical field.

Example

Signals are generated in each laser and are combined in the multiplexer. After the 
multiplexer, the channels at frequencies 193.1 and 193.2 THz overlap, so they are 
added to the same band (see Figure 43).

Sampled signals can also have spatial representation for the spatial modes. If you are 
using the multimode component library, the sampled signals will also have the spatial 
distribution of the signal power for both polarizations. 

Optical signals can also be represented by individual samples, allowing for time-
driven simulations. In order to simulate using individual samples, the user should 
explicitly add the component "Convert to Individual Optical Samples" into the layout. 
Only sampled signals can be converted into individual samples. The number of 
individual samples is defined by the global parameter Number of samples. If the input 
signal has multiple channels, each channel will have an individual sample and center 
frequency, allowing for WDM and Time-driven simulations. Refer to the tutorial lesson: 
Working with individual samples.
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Figure 43 Overlapping channel frequencies

Parameterized signals

The signal description based on the Sampled signals covers the majority of physical 
phenomena affecting the system design. When designing a system where the power 
budget analysis and the fast signal-to-noise ratio estimations are the main 
performance evaluation results, signal channels can be approximated by their 
average power, assuming that the detailed waveform of their data streams are not 
important. One application example is the investigation of the transmission behavior 
of the central channels in dense WDM systems, or an estimation of the EDFA 
performance in the steady-state regime.

Parameterized Signals are time-averaged descriptions of the sampled signals based 
on the information about the optical signal (for example, Average power, Central 
frequency, and Polarization state).

Example

Signals are generated in each laser using parameterized representation and 
combined in the multiplexer. Signals are represented by power and frequency (see 
Figure 44).
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Figure 44 Signals combined in the multiplexer

In the typical simulation of optical amplifiers in a WDM system, the model of an EDFA 
uses the static solution of the rate equations. Each WDM channel is a sampled signal 
with the information about the signal waveform (for example, center frequency, 
sample rate and a large number of samples). The WDM channels are close to each 
other, and can be in separate channels or together in the same band using a total field 
approach. The center frequency of the signal pump is far from the signal channels, 
making it inefficient to include the pump in the same band as the signal channels. 
There is no information content in the bandwidth range between the channels and 
pumps. The signal pump is also a CW signal, and can be represented as a 
parameterized signal by such statistical parameters as its power and wavelength.

The other type of signal is the ASE generated by the amplifier, which can also be 
represented in an alternative way by the power spectral density of the ASE bandwidth 
instead of the sampled signal. OptiSystem separates noise and signals in the 
spectrum, describing the noise by modifying the parameterized signals to another 
signal representation — Noise bins.
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Noise bins

Noise bins represent the noise by the average spectral density in two polarizations 
using a coarse spectral resolution. The resolution can be adapted to maintain the 
accuracy of the simulation. The main advantage of using Noise bins is to cover the 
wide spectrum of the optical signals or to represent the noise outside the Sample 
signals bandwidths. The noise bin representation is similar to the parameterized 
signals, including the polarization. The main difference is that noise bins are defined 
by the noise power density and the bandwidth of each noise bin instead of by the 
average power (see Figure 45).

Figure 45 Noise bins generated by EDFA

Noise Bins can be created whenever there is a source of optical noise, such as optical 
amplifiers. You define the initial resolution and bandwidth of the noise (see Figure 46).
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Figure 46 Mixed signals generated by EDFA

During transmission, the widths of the noise bins are adapted automatically to 
describe the filtering of the noise with a specified precision. The noise bins shrink in 
width as they propagate through the simulation in order to maintain the discretization 
accuracy (see Figure 47).
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Figure 47 Filtering noise bins – adaptive band of each bin





Optiwave
7 Capella Court
Ottawa, Ontario, K2E 7X1, Canada

Tel.: 1.613.224.4700
Fax: 1.613.224.4706

E-mail: support@optiwave.com
URL: www.optiwave.com


	Table of contents
	Installing OptiSystem
	Hardware and software requirements
	Protection key
	OptiSystem directory
	Installation
	Technical support

	Introduction
	Benefits
	Applications
	Samples library
	Main features
	Notes:

	Quick Start
	Starting OptiSystem
	Main parts of the GUI
	Project layout
	Dockers
	Component Library
	Project Browser
	Description

	Status Bar
	Loading a sample file
	Running a simulation
	Displaying results from a visualizer


	Component parameters
	Viewing and editing component parameters
	Editing parameters
	Editing visualizer parameters

	Global parameters
	Editing global parameters
	Using the Layout Editor
	Connecting components manually
	Saving the design and closing OptiSystem

	Notes:

	Appendix A: Global Parameters
	Opening the global parameters dialog
	Editing global parameters
	Simulation parameters
	Simulation window
	Reference bit rate
	Bit rate
	Time window
	Sample rate
	Sequence length
	Samples per bit
	Number of samples

	Signals parameters
	Iterations
	Initial Delay
	Parameterized
	Synchronize

	Noise parameters
	Convert noise bins

	Spatial Effects Parameters
	Space Width X
	Space Width Y
	Grid Spacing Width X
	Grid Spacing Width Y

	Signal Tracing Parameters
	Calculate Signal Tracing
	Power Unit
	Frequency Unit
	Decimal Places
	Sensitivity
	Resolution
	Calculate Noise Floor
	Interpolation Offset


	Appendix B: Signal representation
	Binary signals
	M-Ary Signals
	Electrical signals
	Optical signals
	Sampled signals
	Example

	Parameterized signals
	Example

	Noise bins



